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1. Introduction 

Graybox trading software application from Hold Software.com Inc is a state-of-the art 
trading software that is easy to configure. Using Graybox, you can send multiple orders 
to every ECNs, at different prices, with a single keystroke, and in less than a second of 

your time. 

Graybox™ is power-packed with features such as dynamic and static smart orders, 
blasting, super ECN ordering, and adjustable close out features:  

• Direct access to NASDAQ, ECNs, NYSE, AMEX and access to Dark Pool Providers 

• Scientific Analytical Charts and Tools for effective market monitoring 

• Personalized Position Manager to monitor and adjust your positions instantly  

• The Graybox quote display – a quote monitor for market makers and ECNs 

Your Graybox™ is easily customizable and supports multiple trading styles such as 

scalping, momentum, swing, and position. Its multi-server architecture eliminates 
system overload, enabling execution of hundreds of trades a day. When you are powered 

with all the data that you need – from Level II quotes to late-breaking news – right in 

your trading screen, you seldom make a wrong trade.  

This user manual provides a detailed overview of Graybox™. Performance of the product 
is constantly assessed under real time operations and is instantly upgraded with new 
features in line with the dynamic industry trends.  

Graybox supports all 32 & 64 bit versions of Windows XP, Windows Vista, & Windows 7 
operating systems.  

Please refer to Hold Brothers Support website (http://www.support.hold.com/) for  

latest updates on the product. 
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2. Graybox Basics 

This section explains the basic features of Graybox, including logging in, features of  
main window, how the user can customize a layout, and the entitlements that a user can 
avail of. 

2.1. Logging on to Graybox 

To log on to Graybox:  

1. Click Start.  

2. Select Programs > Hold Brothers > Graybox Trader. Graybox Logon screen 
is displayed as shown in Figure 1.  

Or 

You can also double click Hold Brothers icon on the desktop. 

  

Figure 1: Logon Screen 

3. Enter your trader ID and password in the Trader ID and Password fields. 

  The system automatically displays your default BRSQ account number.  

 

The administrator will provide your Trade ID and Password. 

You can change the password after first login. 

4. Click OK. The Graybox main window appears as shown in Fig 2. 
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2.2. Main Window 

After you log on, the Graybox main (default) window appears as shown in Figure 2. 

 

Figure 2: Graybox Main Window 

The Graybox main window menu consists of: 

• File: The dropdown menu consists of the following options:  

o Layout – to customize and save the layout (see Section 2.3) 

o Change Password – to change your Trader ID password  

o Exit – to close the application 

• Edit: Gives you the option to adjust edit preferences for order quantity. The 

dropdown menu consists of the following options: 

o Quantity   

� 100s 

� 1000s 

� Manual 

� Position 

� Odd Hundred 

� Odd Thousand 

• View: Enables you to set up the View screens along with the GrayBox main 
window. You can select the required screens for the dropdown menu. The menu 
consists of the following options:  

o Notifier 

o Positions Monitor 
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o Hedges Monitor 

o Messages Ticker 

o Locates Monitor 

o Executions Ticker 

o Market Clock 

o Menu 

o Status Bar 

o Tool Bar 

o Title 

o Always on Top 

 

When selected, the respective commands open in separate 
windows. 

• New: This option enables you to open a new: 

o Market Maker 

o ECN Book 

o Chart 

o Boardview 

o Ticker 

o NYSE Openbook  

o Manual Order Entry window 

o Time and Sales 

• Trading: This option helps you to place, manage, and cancel orders using 
different options. To know more about trading, Order Entry. The dropdown menu 

consists of the following options: 

o Preference Window 

o NSDQ/ SDOT Orders 

o ECN 

o Order 

o Cancel 

o Close Outs 

o Trailing Stops 

• Tools: This option helps you to assign trade, open blotter and assign trades. 

• Configuration: This option helps you to configure the keyboard shortcut and 
system for the transaction. You can set the font, color, and sound for the 

application. For more details, see Chapter 3: Graybox configuration. This 
dropdown menu consists of the following options: 

o Fonts 

o Colors 

o Sounds 

o Trading Options 
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o Keyboard Config 

o Execution Options 

o System Config 

o Diagnostics 

o Reconnect All – Use Primary Settings 

o Reconnect All – Use Secondary Settings 

• Help: Help menu provides option for sending the log files created by Graybox to 
the Graybox support team, as well as clean this log files. Apart from above you 
can access help to open the manual, and know Graybox version and contact 

information about Graybox.  

2.3. Customizing Layout 

To customize the layout: 

• Go to Load, and then Select saved multiple layouts to bring up the exact layout. 

To save your current layout for Graybox   

• Click File > Layout > Save.  

To change layout and save it in a different name / multiple layouts  

• Go to File > Save as. 

 

By default, Graybox opens the last layout used.  

Predefined layouts are copied during Graybox 
installation. A preview of the layout is shown 
during installation 
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2.4. Changing Password 

Perform the following steps to change the password: 

1. Click File and select Change Password as shown in Figure 3. The Change 

Password screen is displayed as shown in Figure 3. 

 

Figure 3: Graybox Main Window 

2. Enter the Old Password and the New Password in the respective text boxes. 

 

Figure 4: Change Password Screen 

3. Re-enter the new password in the Confirm New Password text box. 

 

Passwords have to be at least 7 characters long 

and must contain at least one numeric. 

 

4. Click OK. 
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2.5. User Entitlements 

To view user entitlement, Right click on Graybox main window, and click “View 
Entitlement” the following entitlements are available for the user: 

• Buying Power: Displays the buying power you are entitled to. 

• Floating Exposure Limit: Displays your floating exposure limit over and above 
the Buying power. 

• Max Order Size: Displays the maximum size per order. 

• Max Position Per Stock: Displays the maximum positions that the user can take 
per stock. 

• Max Number of Positions: Displays the maximum positions available to you. 

• Stock Price Limit: Displays the Stock Price Limit. 

• Stop Loss: Displays your Stop Loss Limit. 

• Force CloseOut Loss Limit: Displays where the Force CloseOut triggers over 
and above the Stop Loss limit. 

 

Figure 5: User Entitlements window 
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3. Graybox Windows 

Graybox contains many windows that display order details, order status, and so on. 

3.1. Active Orders Window 

The active orders window displays your active/live/pending orders in the market. 

 

 

Figure 6: Active Order window 

 

For Active orders window menu details, see 3.1Active Orders Window 

Following are the columns in the Active order window: 

SN Sequence Number 

S Side: Buy or Sell 

Type Type of order (limit, market, etc) 

Sym Stock symbol 

Qty Number of shares to buy or sell 

Price Price of the stock 

Since Duration (in hours:minutes:seconds) from the time the order has been 

accepted by the exchange. 
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Status The exchange and status of the order: 

New indicates that the order is just entered. 

Floating indicates that the order is floating. 

Partial indicates that the order is partially filled.  

Cancel indicates that the cancel order is sent. 

Auto Cancel indicates that the application is attempting to cancel the 
order. 

TRL Stop indicates that the order is a trailing stop order  

TIF Time in force.  

 

 

After an order is completely filled or canceled, it moves to the Messages 
window. If an order is rejected, it is immediately removed from the Active 

Orders window and shown in the Messages window. 

 

Graybox on logging on to the system can figure out the status of floating orders from the 
previous session linked to a user id. 

For more details on the status of an order, double-click the order to see the Order 
Details window. 

3.1.1. Order Details Window 

The Order Details window displays order details. To view order details, double-click the 

order in the Active order window. 

The Order details can be got from Messages window too.  

Your order details are displayed as shown in Figure 7. 

All orders that are entered are displayed in the Order Details window until these orders 

are cancelled, expired, or executed. 

When there is no order, this is disabled. 

 

Figure 7: Order details 
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3.2. Messages Window 

The Messages window displays messages related to orders. Separate views are available 
for all message, execution, and cancellation orders for the day. 

 

 

Figure 8: Messages window 

This window shows all orders that have been executed, cancelled, user trashed, or 

rejected and hence no longer active. 

When there is nothing displayed in the messages window, it means no transaction, 
whatsoever, has taken place for this trading day. 

For more details on the status of an order, double-click the order. The Order Details 

window (Order Details Window3.1.1) shows the status and the error message, if any. 

3.2.1. View Selections 

You can narrow down the incoming messages that are displayed in the Messages 

window. There are four tabs available in the Messages window. They help you in viewing 
the required incoming messages. Based on your trading needs, you can select one of the 
following tabs: 

All To view All orders 

Execs To view only executed orders 

 

Following are the columns in the Messages window: 

SN Sequence Number 

S Side: Buy or Sell 

Sym Stock symbol 

Qty Number of shares to buy or sell 

Price Price of the stock 
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Time Time when the order is executed or cancelled 

Status The exchange and status of the order.  

Cancel indicates that the order is cancelled. 

Executed indicates that the order is executed. 

 

 

You can adjust the column width by using the mouse. 

3.3. Position Window 

The Position window displays your stock position details. This window is divided into two 
parts. The upper part of the window displays a detailed stock position and the lower part 

displays the summary. 

 

Figure 9: Position window 

 

Figure 9: Position window shows long positions in green and short 
positions in red. 

The upper part of the Position window displays the position of the stock in different 

columns. Following are the columns in the Position window: 

Tabs Description 

Sym Stock symbol. 

Qty Quantity currently owned.  

AvgPrice The average price at which the shares were bought.  

P/L Gross profit or loss on a particular position.  

$ P/L Total dollar profit or loss of a particular position.  

Bid Price at which the buyer is ready to buy. 

Ask Price at which the seller is ready to sell. 

Hi Highest price at which the stock is traded for the day 

Lo Lowest price at which the stock is traded for the day 

Hedges Open straddle positions 

Last Last traded price of the stock 

Last Update Time when the position was last updated 
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The lower part of the position window displays the position summary of the stock. 

Following are the columns in the position summary window: 

Close P/L Net Profit/Loss at a given point of time, for closed positions 

Open P/L Notional Profit/Loss for open positions (Marked to the bid for 

long positions and to the Ask for short positions.) 

Buying Power Amount/Exposure currently available for taking positions 

Shares Count Number of shares traded up to a given point of time 

Total Exposure Amount utilized to buy/short sell shares at the position entry 
price. Sum total of exposure of all the stocks in the position  

Net P/L Open Net Profit or Loss on the position calculated on the 
commission provided in the commission rate in the trading 

options. If not provided in the trading options, it is the close 

profit/loss. 

Column headers – Upper part of position window 

You can customize column headers of the upper part of the Position window. If you do 

not wish to view only the column headers, right-click on Position window and click 
Show/Hide Header, see Figure 10. Repeat this procedure to view only the column 

headers. 

 

Figure 10: Position window menus 

You can customize and view only the required columns of the upper part of the Position 
window. To customize the column header: 

1. Right-click the Position window and click Column Setup. The Column setup 
window appears as shown in Figure 11. 



Graybox – User Manual_v3.63  

 

 

20 

 

Figure 11: Customizing upper Position window 

2. Select the required column headers from Column Headers list. The functions of 

the buttons are as follows: 

o > : To move the selected column header from the Column Header list to the 
Selected list 

o < : To move the selected column header from the Selected list to the Column 
Header list 

o >> : To move all the column headers from the Column Header list to the 
Selected list 

o << : To move all the column headers from the Selected list to the Column 
Header list 

o Up: To move up the list 

o Down: To move down the list 

3. Click OK. 

Column headers – Position summary 

You can customize the position summary window. If you do not wish to view the column 

headers,  

• Right-click the Position window and then click Show/Hide Header See Figure 

12. Repeat this procedure to view the position summary column headers. 

You can customize and view only the required columns of the upper part of the Position 
window. 

You can customize and view only the required columns in the position summary window. 
To customize position summary column headers: 

1. Right-click the Position window and then click Summary Setup. The Summary 
setup widow appears as shown in Figure 12. 
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Figure 12: Customizing position summary window 

2. Select the required column headers from Column Headers list. Functions of the 
buttons are as follows: 

o > : To move the selected column header from the Column Header list to the 
Selected list 

o < : To move the selected column header from the Selected list to the Column 
Header list 

o >> : To move all the column headers from the Column Header list to the 

Selected list 

o << : To move all the column headers from the Selected list to the Column 
Header list 

o Up: To move up the list 

o Down: To move down the list 

3. Click OK. 

Position Close Out 

You can use this option to close the trading of a particular stock. This option closes out 

the open position of a particular stock by selling longs and buying shorts at the current 
market price.  

To close trading of a particular stock,  

• Right-click the Position window and then click the required Position Close Out 
option.  

Close Out 

You can use this option to close the trading of all open stocks. This option closes out all 

open positions by selling longs and buying shorts at the current market price. 

You can configure the Graybox to the preferred close out positions.   

To configure the close out positions,  

Right-click on main window > Setup > Close Out Keys. Close Out Keys Setup box 
appears. See Figure 13. 

To close trading all open stocks, 

• Right-click the Position window and then click the required Close Out option. 
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Figure 13: Close Out Keys – Setup  

 

 

Close out keys can be configured as hot keys from the KeyMapConfig 
window 

. 
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3.4. Executions – Ticker Window 

The Execution window displays all executions.  

 

Figure 14: Execution –Ticker window 

Following are the columns in the Execution Ticker window: 

Tabs Description 

Time Execution time of the order 

SN Sequence number 

Side Sell or Buy 

Sym Stock symbol 

Qty Number of shares executed 

Price Price of the stock 

Exch Exchange through which the shares are executed 

Contra The contra party for the transaction 

Comm. Commission in dollars 

Pos Stock position 

Exec P&L Execution Profit and Loss 

Pos P&L Position Profit and Loss 

Total P&L Total Profit and Loss 

3.5. Notifier 

The Notifier window displays all the system messages that are related to Graybox. These 
include periodic system announcements that are made by the Graybox system 

administrators. 

When Status of the order is to be checked, Right click on the order in Graybox active 
order window, and click on “Get Status”. The status of the order is displayed in Notifier 

window 
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Figure 15: Notifier Window 

 

Following are the columns in the Notifier window: 

Tabs Description 

Time Time when the message is relayed by the administrator 

From Source of the message 

Message Detailed message 

Severity Criticality of the message  
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4. Order Entry 

You can make order entries in different ways and in different windows. This chapter 
explains different ways of placing orders and routing them.  

4.1. Market Maker – mini Order Entry window 

The Market Maker window consists of a mini order entry screen. This window routes 
orders to all available ECNs/Exchanges. You can trade both listed and OTC securities by 

using the mini Order Entry window. You can also place different types of orders such as 
Stop, Stop Limit, MOC, and LOC and change the Time In Force for an individual order.   

To view the mini Order Entry window from Market Maker window: 

1. Right-click the Market Maker window. 

2. Select View> mini Order Entry window. The mini Order Entry window appears 
in the middle of the Market Maker window. 

 

Figure 16: Market Maker – mini Order Entry window 

 

You can disable the mini Order Entry window if you do not want to 

view the window. This can be done using the right click menu option 

in Market maker window. Right click in market maker window, in the 
menu, select “View� Mini order entry” , check/ uncheck to 
enable/disable mini OE window 

Up and Down Arrow keys can be used to increment/decrement price 
of a symbol for order entry 

 

mini Order 
Entry 
window 

Level I Display 

Level II 
Display 
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4.1.1. Setting Order Type 

You can change the order type and side in the mini Order Entry window. You can 

make the following changes in the required order. 

To change the type of an order, click the order type list. The dropdown menu in 

Figure 17 displays the different types of orders available. 

 

Figure 17: Order types 

 

The Limit price and the Stop Limit are updated by real time quotes 
based on the current Inside Market. 

The different types of order available are  

• Limit 

• Market 

• Stop 

• Stop Limit 

• Market on Close 

• Limit on Close 

• Trailing Stop 

• Trailing Stop Limit 

• Opening Cross 

• Dynamic Smart 

• Regular Smart 
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4.1.2. Set Order Price  

Price of the order is set by  

• Manually  by typing in the order price 

• Selecting “Live” mode, the order price will change accordingly to the last “Bid” or 

“Ask” on the “Level 2” display 

• Point and Click using mouse on the “Level 2” Display, changes price, based on 
where the mouse was clicked – Should be enabled from the Mini OE Setup. 

4.1.3. Set Order Quantity 

Order quantity can be entered manually. 

From the “RESV” option you can set the default display quantity, reserve quantity 

and the step size for increasing /decreasing the quantity.  

4.1.4. Switching between Live and Custom Mode 

To enable price change according to the last “Bid” or “Ask”, Click LIVE. This can be 
toggled to enable or disable live updates as the market changes. 

4.1.5. Time in Force 

Time In Force (TIF) denotes the number of seconds the orders remain afloat before 
they time out. By default, TIF is set to 180 seconds. However, you can change the 
TIF for individual orders. 

If LIVE is clicked, the order gets updated by current market price automatically. If 
the price is changed manually, the LIVE mode gets disabled.  

 

Do not set the default TIF below 120 seconds for INCA orders. 

Else, the order(s) get rejected. 

You can change the TIF type for a particular order from the TIF dropdown list as 
shown in Figure 18  

The options available for Time in Force are  

• Default TIF 

• Day 

• IOC 

• At Open 

• Open X Imbalance 

• Close X Imbalance 

• Intraday X Only 
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Figure 18: Changing Time in Force 

 

All orders go out with a Default TIF (as selected in Trading 

Options) unless they are manually changed for a particular order. 

4.1.6. Buy & Sell  

To switch between order sides, Click BUY/SELL as required. 

By default, the buy side price is the best inside ask and the sell side price the best 
inside bid. However, to toggle the quote side, click BID/ASK. If you change the 
prices manually, the window stops updating the Limit/Stop Limit entry fields and the 

order does not remain Live. To return to the live mode, Click Live.  

 

4.1.7. Setting Destination Exchange, Routing Modes & Strategies 

Graybox allows you to trade through different exchanges. You can select the 

required routing strategy. You can toggle between routing modes/strategies using 
the Order Entry window.  

A destination Exchange can be made default by using the ‘Lock- ’ button provided 
next to destination drop down box. Select a destination and lock it, all orders will be 

sent to this destination. Once locked this destination is default order destination in 

the current market maker window’s mini order entry. Unlock  this button to select 
multiple destination.  

To change the routing modes/strategies: 

1. In the Order Entry window, click the Destination Exchange drop down 
menu.  
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2. Select the required routing mode/strategy from the dropdown list as shown 

in Figure 19. The order is now routed through this mode/strategy to the 
exchange.  

Various Routing Options are available. They are 

2.1.  BATS MPP: This is BATS Midpoint peg order which sets the price at 

the midpoint of National Best Bid and Offer (NBBO).   

 

Figure 19: Changing routing exchanges 

 

4.1.8.  Add & Remove Liquidity 

Mini Order entry from the market maker window gives you the facility to Add or 
remove liquidity from the Market maker window itself. 

Using this option will help you set the price, so as to add or remove liquidity from 
market. 

4.1.9.  Setting Routing Order Buttons 

Routing exchanges and routing modes are displayed in the Destination Exchange 

drop down menu to help you in fast trading. You can customize the routing order 
buttons displayed on the Order Entry window. To rearrange the routing order 
buttons in the Order Entry widow: 

1. Right-click Market Maker window. 

2. Select Setup > Order Entry Window > Order Buttons. The Routing 
Order Buttons window appears. 
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Figure 20: Routing order buttons 

3. Select the required routing order buttons from Column Headers list. 
Functions of the order buttons are as follows: 

> : To move the selected routing order button from the Column Header list 
to the Selected list 

< : To move the selected routing order button from the Selected list to the 

Column Header list 

>> : To move all the routing order buttons from the Column Header list to 
the Selected list 

<< : To move all the routing order buttons from the Selected list to the 

Column Header list 

Up: To move up the list 

Down: To move down the list 

4. Click OK. 

4.1.10. Cancel All open orders. 

All orders for a selected stock in market maker window can be cancelled using the 

“Cancel All” button  in miniOE window. 

4.2. ECN Order Entry Windows 

ECN orders can be launched using individual ECN or using shortcut keystrokes.  

 

Keystrokes for launching an ECN order are explained in the Keyboard 

Reference in chapter 6. 

 

To open an ECN order,  

• On the Trading menu, select the required routing exchange and then click the 
required entry type. 
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Figure 21: ECN order entries 

Figure 21 depicts the ECN order entries available under ARCA routing exchange. 

Following sections provide a detailed explanation on ECN order entries. 

 

The Super ECN key sends orders to all ECNs at the price specified in 
the Preference Order box. These orders go out at default quantity size. 

 

4.2.1. Sending ARCA/BATS/TRAC/INET/RASH Buy Entry 

You can send buy order entries through any exchange. To send a buy order entry on 
any exchange: 

1. Open any Buy Entry window 

2. Enter Stock name and stock Quantity 

3. Use the left/right arrow keys on your keyboard to select the price (1 cent 
per keystroke) or use the Step option. 

 

Figure 22: Sending Buy Entry 

4. Click Buy. 
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4.2.2. Sending ARCA/BATS/TRAC/INET/RASH Sell Entry 

You can send sell order entries through any exchange. To send a sell order entry on 

any exchange: 

1. Open any Sell Entry window. 

2. Enter Stock name and stock Quantity. 

3. Use the left/right arrow keys on your keyboard to select the price (1 cent 
per keystroke) or use the Step option. 

 

Figure 23: Sending Sell Entry 

4. Click Sell. 

4.2.3. Sending ARCA/BATS/TRAC/INET/RASH Short Sell Entry 

You can send short sell order entries through any exchange. To send a short sell 
order entry on any exchange: 

1. Open any Short Sell Entry window. 

2. Enter stock name and stock quantity. 

3. Use the left/right arrow keys on your keyboard to select the price (1 cent 
per keystroke) or use the Step option. 

 

Figure 24: Sending Short Sell Entry 

4. Click Short Sell. 
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4.3. Preference Window 

The Preference window is used to make order entry in the Active Order window. To open 
Preference window, on the Graybox Main window – select Trading>Preference 

Window and select the order type. 

 

Figure 25: Opening Preference Window 

The Preference Bid, Offer, Short Offer, Pref. Buy, Pref. Sell, and Pref. Short Sell options 
open the Preference window as shown in Figure 25 . 

 

Figure 26: Preference window 
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You can open the Preference window using shortcut keys set in Keyboard 

configuration. 

To enter an order in Preference window: 

1. Open the required Preference window. 

2. Enter the Symbol, Price, and Quantity. 

3. Increase/decrease the price in steps using the Step list. 

4. Select the routing exchange, execution platform, routing strategy, and order 

type. 

5. Select PRELOAD to load data. 

6. Click Buy/Sell/Short Sell based on the preference type to submit the order. 

4.4. Trailing Stops– Buy/Sell 

Trailing Stop Loss Buy is a useful stop loss order. You can set stop loss price at some 
fixed price/percentage below the market price. When the stock price rises, the Stop Loss 
Buy price rises proportionately. When the stock price falls, the stop loss price remains 

the same ands gets executed at match price. See Figure 27. 

Trailing Stop Loss Sell is a useful stop loss order. You can set stop loss price at some 
fixed price/percentage below the market price. When the stock price rises, the Stop Loss 
Sell price rises proportionately. When the stock price falls, the stop loss price remains 

the same ands gets executed at match price. See Figure 27. 

Trailing stop setup can be accessed by right click on the main window, go to ‘Setup’ and 
‘Trailing Stop’. This will open the Trailing Stops setup window Figure 27. 

While placing the Trailing Stop Loss/Buy enable “Use Delta from Market” option and set 
“Delta from Market”. See Figure 28.  

 

 

Figure 27: Trailing Stops Set Up 

The ratio in change in the price of the underlying asset to the corresponding change in 
the price of a derivative is known as Delta. This is sometimes referred to as the "hedge 
ratio". 

By setting Trailing Stop Loss Buy/Sell, you can limit the loss while not capping your 

gains. Also, you do not have to constantly monitor your investments.  
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Trailing Stop order can be auto triggered when entering positions. This setting can be 

enabled or disabled by putting a check mark in the “Auto Trigger Trailing Stop on 
Entering Positions” entry from Trailing Stops Setup window,  

 

 

 

Figure 28: Trailing Stops– Buy / Sell/ and Stop Sell Windows. 
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4.5. Changing a Floating Order 

An order that is not executed/ pending is called a floating order and these orders can be 
changed. 

 

Figure 29: Changing a floating order 
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4.6. Canceling an Order 

You can cancel unexecuted orders. You can cancel orders in different ways. 

 

Figure 30: Canceling orders 

To cancel an individual order: 

1. Select the order in the Graybox main (active order) window. 

2. Click Cancel Order. 

Or 

On the Trading menu, point to Cancel and then click Selected Order.  

Or 

Press F12 key. 

 

Orders may still be filled while they are being cancelled or before they are 
routed to the exchange. For cancellation confirmation, click in the Messages 
window and verify if the order is actually cancelled. SelectNet orders must 

be active for at least 10 seconds before they are canceled. 

To cancel all orders: 

• In the Graybox main (active order) window, click Trading menu, point to Cancel 
and then click All Orders.  

Or  

• Press Ctrl+F12. (This is the default keystroke). The 0 button on the number pad 
cancels all orders in a selected stock.  

To cancel all orders for a selected stock: 

1. Select the stock so that it appears in the Graybox main window.  

2. On the Trading menu, point to Cancel and then click All For Selected Stock.  
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Or 

Press F11. (This is the default keystroke). 

To cancel all buys for an individual stock: 

1. Select the stock so that it appears in the Graybox main window.  

2. On the Trading menu, point to Cancel and then click All Buy Orders.  

Or 

Press the Shift+F12. (This is the default keystroke). 

To cancel all sells for an individual stock: 

1. Select the stock so that it appears in the Graybox main window.  

2. On the Trading menu, point to Cancel and then click All Sell Orders.  

Or 

Press the Alt+F12. (This is the default keystroke). 

3. Canceling SNET and SOES orders 

4.7. Manual Order Entry Window 

1. On the Graybox Main window, select New>Manual Order Entry. The Manual 
Order Entry window appears as shown in Figure 31. 

 

 

Figure 31: Manual order entry 

2. Enter the following information: 

o Order Side: Select the type of order, either Buy or Sell 

o Quantity: Enter the order quantity 

o Symbol: Enter the required stock symbol  

o Price: Select the order price 

o Type: Select the order type  

o Time In Force: Select how long the order is valid. See 5.1.3. 

o Destination : Select the destination exchange  

3. Click Send. 
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5. Graybox Configuration 

The configuration of the Graybox is done through the Trading Options window, by setting 
up smart order routing, dynamic smart orders, and keyboard shortcuts. 

5.1. Configuring Trading Options 

You can configure your Trading Options through the Trading options window. You can set 
Order Display Mode for different exchange orders, IOC Mode for different orders, Display 

Size Defaults, Default Qty Per Stock, and Different Trading Options.  

 

Every configuration setting made in Trading Options is saved in a central 
location and provides for a roving profile. However, the display elements 

are saved as part of the local layout, and they must be transferred in 
order to maintain the same look and feel. 

To customize trading options for Graybox: 

1. Right-click the active order window. 

2. Select Trading Options from the popup menu. The Trading Options window 

appears as shown in Figure 32. 

  

Figure 32: Trading Options Window 
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5.1.1.  Default Quantity  

You can set your default share quantity for Listed/OTC stocks here. The Listed/OTC 

stocks carry the set quantity to the default every time a new stock is typed. 

 

Figure 33: Default Quantity Box 

 

5.1.1.1. Order Display Mode  

You can set your order display mode by using this option. There are three types 
of order display modes: Automatic, Normal, and Hidden. 

      

       Figure 34: Order Display Mode Box 

• Normal: All orders going to an ECN are marked as “Normal” and they 

are shown on the NASDAQ Level 2 display as well as the ECN book. 
However, “Normal” orders cannot lock or cross the market. If you 
attempt to do this, the order is rejected. 

• Automatic: Graybox detects the orders that can potentially lock or cross 

the market and sends them out as “Subscriber Only”. All other orders go 
out as “Normal.” 

• Hidden: The SNET preference box allows you to send hidden orders to 

Island by selecting the Hide check box on the preference box. The order 
is not visible on Level 2 or the Island book.  

5.1.1.2. Market Maker Settings 

You can make different settings for your MMaker window here. 

 

Figure 35: Market Maker Settings Box 

Show Firm/Hedge Position - shows the number of traders, trading from a firm. 
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Cancel Retry on Reject 

See Market Maker Settings Box in Figure 35. 

Once the Cancel key is hit, Graybox automatically resends cancel requests for 
SOES and ECN orders. 

 

5.1.1.3. Automatic Close Mode 

Automatically changes the quantity to your current Long or Short position in that 

particular stock when you go to cover your position. 

 

     Figure 36: Auto Close Mode 

 

However, if the position is greater than your default qty size, then 
the order will go out for the default size. For example, if you were 

long 375 shares of CSCO, and your default is a 1000, your 
quantity for CSCO would go out for 375 shares. 

Reset Share Size according to default quantity 

This feature resets the share size after taking into account the default quantity 
and the current position. For example, if you are long 100 shares of DELL and 
your default Quantity for DELL is 1000, the next order (only the next order) 

automatically goes out for 900. 

5.1.1.4. Smart Order Auto Cover 

This option is not available in the Trading Options image. 

When using Smart Ordering, Smart Orders detects an open position, if any, for 
the specified stock and resets the quantity to cover the position. So, instead of 
sending out orders for your default quantity size, it sends orders for your open 

position.  

 

If your open position is greater than your default qty size, the 

order goes out for the default qty size only.  

 

5.1.2. Order Entry, Positions Window Mode, & Level 2 Order 
Settings 

You can select default ECN Order Entry Settings here. 

 

Figure 37: Order Entry, Positions Window Mode & Level 2 Orders Settings 

Box 
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For manual order entry box, the default ECN can be set in ‘Manual OE listed Default’, 

& ‘Manual OE OTC Default’.  

The default price for ‘ECN order entry’ as add or remove liquidity can be set. 

There are two modes available for Positions Dialog Mode: Floating and Docked. If 
you enable Floating, Positions window and Graybox window can be moved 

separately.  If you enable Docked, the Positions window is attached to the Graybox 

main window and moves with it. 

Order can be displayed as a bar with options to cancel the order in Level 2 window 

using the options in ‘Orders in level 2 Wnd’.  

5.1.3. Time In Force  

Time in Force sets the period for which an order should stay active. 

The default is set as DAY orders. Day orders in Graybox remain active through the 
trading day including post market hours. 

 

Figure 38: Time in Force Setting Box 

If “Use TIF In Secs” is selected for Default Time In Force, then a valid value in 
seconds is needed for the Time In Force (In Secs) field. 

5.1.4. IOC Mode  

This box enables you to configure settings for Immediate Or Cancel Mode. All your 
orders are filled either immediately or cancelled. 

The default value can be set for each ECN\Exchange supported by Graybox. 

• IOC: All Orders go out as Immediate or Cancel. If the ECN has a match 

in their books, the order gets filled, or else the order is automatically 

cancelled. 

• Normal: Orders are sent out with the default Time In Force. This allows 

the ECN to be proactive in the order matching and forward orders to 

SNET or other ECNs if a match is not found in the books.  

 

This feature can delay cancel orders at times   

• Automatic: This allows Graybox to determine whether orders go out as 

IOC or Normal. By default, all orders that post liquidity are sent out as 

Normal and all orders that grab liquidity are sent out as IOC. For 

example, all Buy orders above the offer go out as IOC, while all buy 
orders under the offer go out as Normal. 



Graybox – User Manual_v3.63  

 

 

43 

5.1.5. ECN\Exchange Routing Mode 

You can set your ECN Routing Modes here. 

 

Figure 39: Rash Routing Mode Box 

Default routing modes can be set for each Exchange\ECN if the routing is enabled. 

5.1.6. Display Size Defaults/ECN 

You can set your Display Size Defaults/ECN here. 

 

Figure 40: Display Size Defaults/ECN Box 

For each ECN, the display size can be set in the following ways: 

• As default  

• As order quantity  
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• As some value. Example: 100, 200 and so on. 

5.1.7. Scroll settings for Maximum and Minimum Qty 

The will change the maximum and minimum quantity that can be changed using 
scroll.  

 

5.1.8. Default Quantity Per Stock 

You can set the default quantity of shares per stock here. The stock carries the set 

quantity every time the stock is typed.  

 

Figure 41: Default Qty Per Stock Box 

• To set the default quantity shares per stock: 

• Type the chosen stock name in the Stock field and specify the default 
quantity. 

• Click Add. 

 

You can also define the step size by which the price should be 
incremented. 

For each stock, different quantity can be set.  

To delete any stock from the list 

• Select the stock and click Remove. The Default Quantity settings for the 
stock stands removed. 

 

This setting is applicable to all order entry window (Market maker 

order entry window, Mini OE window, Listed Trading window, ECN 
order entry window, and the Preference window. 

This setting is saved to the local layout, not saved as a roaming 
profile. 

5.1.9. Optimization  

You can change the display refresh rate and the book optimization depth here. 



Graybox – User Manual_v3.63  

 

 

45 

 

Figure 42: Optimization box 

5.1.10. Other Settings 

You can make other settings such as Estimated Commission Rate, MM Order Entry 
Display, eSignal (charting software), and Max Compliance Mode here. This option 
enables you to view your approximate profit/loss in the position monitor. This can be 

linked with Graybox in this option. 

You can set Active Order Sort either in Descending or Ascending order. 

You can set Mouse scroll Function to Symbol/Price/Quantity as per your trading 

choice. 

 

Figure 43: Other Settings Box 

5.2. Setting Up Smart Order Routing 

This feature allows you to set up smart order keys (default to CTRL + B, CTRL + S, and 
Shift + S) for one-key execution with the market maker or ECN of your choice. You can 
set up a list of ECNs and market makers as per your priority.  

 

If the first choice is not available, the smart feature moves down the list to 
the next available ECN or market maker and so on until the order goes out. 

• Shift+S - sends a short sell order to your smart order routing list. 

To set up Smart Order Routing: 

1. Shift focus to the active order window. 

2. Right-click the active order window. The Graybox main window appears. 

3. Select Setup in the menu. The Smart Orders Setup window as shown in Figure 
44 appears: 
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Figure 44: Smart Orders Setup Window 

4. Type the four-letter market maker or ECN symbol in the top field. 
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5. Click the Add button (or hit the Enter key). The ECN or market maker appears in 

the routing list.  

6. Repeat steps 4 and 5 for each market maker and ECN that you want to include.  

7. To change the order of a symbol in the list:  

• Select the symbol in the list.  

• Click the Move Up or Move Down button as many times as necessary. 

5.2.1. Split Order by Display Size 

You can split an order by display size. It breaks up your order if the volume is shown 
on level two is less than the size of the order you are sending. For example, if you 
send a Sell Order for 2000 shares, and INET shows 800 shares-the order is split up,  
so that  800 shares goes to INET and the remaining 1200 goes to the next ECN and 

so on.  

 

You can also specify at what price the order should be sent out above 
the Inside Market by adjusting the delta value. 

You can remove an ECN or Market Maker from the list.  

 To remove an ECN or market maker from the list: 

1. Select the symbol in the list. 

2. Click the Delete button. 

You can clear the list and start over. To clear the list, click the Clear button. 

5.3. Dynamic Smart Orders  

Dynamic smart orders work with the same settings as regular smart orders with the 

following exceptions: 

• Dynamic order sends out all orders as IOC orders. 

• Dynamic order sends out the orders again at the same price (or raises the price 

up to 5 times), if the orders are cancelled or rejected. 

5.4. The Super ECN Key 

The Super ECN key, (default Alt+1), sends orders out to all ECNs listed in the setup box 

shown in Figure 45, at the price specified in the Preference order box. You can send a 
NSDQ\NYSE limit or market order for the size specified in this setup box.   

To launch these orders, the preference box must be open. These orders go out as your 

default qty size.  

 

NSDQ\NYSE order goes out for the quantity specified in the setup. 

You can setup the SuperECN key to exclude certain ECNs.  This feature can be used to 

go long, sell, or go short. 

To exclude ECNs from the Super ECN key: 

1. Right-click the Active Order window. The Graybox menu appears. 
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2. Select Setup, and then select SuperECN Key. The Super ECN Key Setup 

window, as shown in Figure 45, appears:  

 

Figure 45: Super ECN Key Setup Window 

3. Click the ECN(s) that you want the Super ECN key to ignore.   

 

Entering 0 in the NSDQ\NYSE box disables the NYSE\NSDQ order. 

4. Select the type of order you want to send out from the dropdown menu of SOES 
order type. 

5. Specify at what price you want to send the order with respect to the Inside 
Market (Buying at the offer/selling at the bid). 

6. Click OK. 

5.5. Direct Super ECN Key 

Graybox set of Super ECN Keys work without having the Preference window or the Listed 
Trading window open. The orders go out at the current Inside Market which are the best 
inside ask for buys and the best inside bid for sells/short sells. They use the same 

setting as used by the other Super ECN Keys. 

 

The keystrokes are disabled by default and can be assigned using the 
KeyMapConfig Window in the MarketMaker tab. 

5.6. Multiple Swipe Keys 

Swipe orders do not go by the best NASDAQ bid/offer, but go at the increment based on 
the best bid/offer for the specific ECN or the Inside Market. The order is placed on top of 
the specific ECN book or Inside Market. 
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ECN swipe keys are commonly referred to as Shave Keys. You can configure five sets of 

ECN swipe keys.  You can send orders at a specified differential (factor) above / below 
the best Bid / Offer for a specified ECN. To launch this order, the preference box need 
not be open, but the keys need to be enabled separately in the keymap configuration. 

For each Bid/Offer sent to an exchange, a factors set for "inside the market" etc 

executions, this maximum factor acts as the referral point. 

 

 Figure 46: Swipe Setup Window 

To configure multiple swipe keys,  

1. Go to the Graybox menu and pick setup.  

2. Then go to the swipe key. To enable the swipe keys: 

o Go to Keymap Configuration and enable the Swipe Keys.  

 

If required, you can change the keystrokes. 

 

3. Select the required Swipe ECN (e.g. INET) and the Swipe Factor (e.g. 0.001), and 
specify if the swipe should be based on the Inside Market or ECN Market. 

 

The SOES Delta Keys allow you to send SOES limit orders at a 
specified increment above the market price. 

 



Graybox – User Manual_v3.63  

 

 

50 

To set the increment,   

On the context menu, click Setup > Swipe.  

In the SOES Delta Value field, enter the decimal value of the increment for the limit 
price.  

 

By default, SOES Delta key functions are disabled and no keystrokes are 

assigned. To use hotkeys, go to the Keymap Configuration and assign 
appropriate keystrokes to the key functions and enable them. 

5.7. Setting Up Keyboard Shortcuts 

In this version of Graybox, the Keystrokes are divided into three lists:  

• Keystrokes for the Graybox main window 

• Keystrokes for the Market Maker window 

• Keystrokes for the Preference and Listed Trading window 

 

Figure 47: Key Map Configuration Window 

Refer to Figure 47 above. All keys that are currently in use are in blue. The key 

combinations for the different functions are in yellow. 

When you highlight a function, the keystroke is highlighted in yellow. For example, when 
you highlight "Cancel All Buy Orders", the keystroke Alt + F12 gets highlighted in the 

Regular Keyboard. 

To customize the keystroke, perform the following steps: 
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1. Select the function for which to customize the keystroke. 

2. In the Key column, click the existing keystroke. For example, in the Pop-up 
window, click the keystroke F12 which relates to the function “Cancel All Buy 
Orders”. The F12 key in the Regular KeyBoard turns yellow.  

3. To change the keystroke from F12 to F11, click the F11 key from the Regular 

KeyBoard. 

4. Click Change to save the changes.  

If the new keystroke you select is already in use for another function, a dialog 
box appears with the message. You must either change the other keystroke first 

so there is no conflict, or disable the current keystroke.  

 

To disable a function in the keystroke configuration table, double click 
in the Disabled column. 

It is a good idea to disable any keystrokes that you do not use, 
especially if you are a new trader. 

You can return to the default key mappings at any time. To return, click the Set Default 

button. This deletes all the keyboard shortcuts that you defined. 

5.8. Trailing Stop Order 

You can set up the trailing stop orders for your trades. For more information on trailing 
stops, refer to Trailing Stops– Buy/Sell 4.4. 

To set Trailing Stops, right click on the main Graybox window > Setup >Trailing 

Stop 

 

Figure 48: Trailing Stops - Setup Window 

You can define appropriate Trailing Stops from the Trailing Stop window Defaults frame. 
You can define Trigger order from the ‘Trigger Based On’ dropdown menu.  The menu 

consists of Last print, bid, ask, and Print- Primary Exch. Then, you define the Trailing 
Stop Use from the drop down menu. The menu consists of Stop Price, Delta from Market, 
and % from Market.  

You can also define the Trailing Stops through Direct Trailing Stop Hot Key frame.  You 
can select Direct Trailing Stop Hot Key from the drop down menu. The menu consists of 
Use Delta from MKT, Use % from MKT. Then, you define Value from the drop down menu 

of Value.  
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You can then set Stop Trigger from the drop down menu of Stop Triggered By. The menu 

consists of Last Print, Bid, Ask and, Last print – Primary Exc. Finally, you can define the 
destination exchange from the drop down menu of Destination. The menu consists of 
BELZ/SOES, NYSE Direct/SOES, AMRO/SOES and, SMART ORDER. 

5.9. Showing or Hiding Parts of Graybox Main Window 

You can set the viewing parts of Graybox main window. To show or hide parts of the 
Graybox main windows: 

1. Click View in the main menu and select the options from the dropdown menu. 
Options of dropdown menu are: 

o Notifier – shows all system messages related to Graybox 

o Hedges monitor 

o Locates monitor – shows the stocks available for the trader which can be the 
deciding factor for the short sell of those stocks. 

o Messages - shows or hides the Incoming Messages such as login/logoff to the 

server, connectivity status, and emergency messages and so on. 

o Positions  - shows or hides the Position window which shows your positions 

and your current available buying power  

o Executions - shows or hides your executions  

o Market Clock – shows or hides the market clock 

o Menu -  shows the menu at the top of the Graybox Active Order window 

o Status Bar - shows or hides the ECN Status Bar which shows the current 

status of the connection between Graybox and ECNs 

o Tool Bar – shows or hides the tools buttons at the top of the Graybox active 

order window 

o Title – shows or hides the title on the Graybox active order winndow 

o Always on Top – This option sets the current window to display always on top 
of other window.  

2. Select the options that must be displayed. 

 

Always on Top, & turning on / off the title, menu, status, and  tool bar 
option is available in most of the Graybox windows like Positions 
monitor, Market Clock, Execution ticker, Notifier window, Hedges & 

Locates monitor. 

5.10. Mini OE Setup 

To access Mini OE setup, right click on the Graybox active order window, from setup 
menu miniOE setup can be accessed.  

1. You can set the options in Default ECN’s to be displayed in mini OE window 

2. Enable/ Disable options for “Enable Point and Click to set price”, “Enable enter key 
to set order”, and  “Enable Double click to Send order”.  

3. To create and edit mini OE short cut – send order buttons. To create a button 
select a destination, select a price and choose a buy or sell action, then click 

create. A new button will be created at the bottom of the miniOE window with the 
selected options. Clicking on this button will send order for the selected stock. 
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Figure 49: mini OE Setup 

5.11. Graybox Main Window – Setting Colors 

You can set the colors for the Main window. To change the foreground and background 

colors for the Stock and Quantity boxes and the message bar, perform the following 
steps: 

1. Right-click the Active Order window. The Graybox menu appears. 

2. Select Setup, then Color. Color Option window appears: 

 

Figure 50: Color Options Window 

3. Click the  button next to Foreground or Background. The color window 

appears. 

4. Select any color. 

5. Click OK. 

6. Click OK again to save your changes.  

5.12. Graybox Main Window – Setting Font 

You can set the fonts for the column headings and tabs in the Graybox main window: 

1. Right-click the Active Order window. The Graybox menu appears. 

2. Select Setup The Fonts window appears. 
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3. Select the required font and then click OK. 

5.13. Graybox Main Window – Setting Sounds 

Whenever a trading event such as an execution, a partial fill, a confirmation, a 

cancellation, or an error occurs, Graybox can play a sound for confirmation.  

Graybox has a set of default sounds, or you can use any .wav file of your choice. 

To set the sound for trading events: 

1. Right-click the Active Order window. The Graybox menu appears. 

2. Select Setup, then Sounds. The Sound Setup window appears: 

 

Figure 51: Sound Setup Window 

3. For each event that you want to associate a sound with: 

a. Click the  button next to the event. A list of sounds appears. 

b. Select the required sound. 

c. Click OK. 

4. Repeat this step for each event that you want to associate a sound with. 

5. When you are finished with assigning sounds, click OK. 

 

To protect your trading application from unauthorized access, you can 
change password as often as you wish. To change your password, See 2.4 

Changing Password 
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5.14. Changing Server and Router Settings 

You can change the Server and Router settings of your Graybox application.  

 

Every configuration setting made in the System Configuration window is 

saved to the data base and could impact trading. Please take trade/tech 
support assistance while configuring this window.  

To change the settings:  

1. Right-click the Active Order window. The Graybox menu appears. 

2. Select Setup, then Servers. The System Configuration window, as shown in 
Figure 52, appears: 

 

Figure 52: System Configuration Window 

3. Configure the server and router settings.  

 

The Graybox Quotes box must be selected to activate the Graybox 

quote display. For correct settings, contact the support group.  

5.15. Links 

To link charts from the Graybox in MM windows and in ECN 
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• Open charts from the main GrayBox, and then open two MM windows with 

different stocks subsequently.  

eSignal is a charting software which can be linked with Graybox. Perform the following 
steps to link eSignal: 

1. Right-click the Graybox icon and then Click Properties. The Graybox Properties 

window is displayed. 

2. Click the Compatibility tab and select Run this program as an administrator. 

3. Click Apply and then click OK. 

4. Right-click the eSignal icon and then Click Properties. The eSignal Properties 

window is displayed. 

5. Click the Compatibility tab and select Run this program as an administrator. 

6. Click Apply and, then click OK. 

7. Click the Graybox icon to Log on to the application. 

8. Enter your trader ID and password in the Trader ID and Password fields. 

 

The administrator will provide your Trade ID and 
Password. 

You can change the password after the first login. 

9. Click OK. The Graybox main window and eSignal main window appears. 

10. Click Page and then click Advanced Charting in the eSignal main window. 

11. Right-click MM window and then click Setup.  

12. Click ESignal Link Scheme and select the required color from available choices.  

13. Right-click MM window and then click Setup.  

14. Click ESignal Link Type and select the option Both. 

15. Click Page and then Save Page to save the page. 

5.16. Cancel Order 

You can cancel orders from the Graybox main window. Canceling orders from Graybox 
main window menu will enable you to execute your cancels faster, as you can place 
cancel orders in groups for Buy, Sell, and Selected orders. To place cancel orders 
through hotkeys: 

1. Right-click the Active Order window. The Graybox menu appears. 

2. Select Cancel from the Trading dropdown menu. 

3. Select the orders that you wish to cancel. 

4. Click OK. 

OR 

5. Click on ‘Trading’ Menu from the active order menu. 

6. Select Cancel from the menu. 

7. Select the orders that you wish to cancel. 

8. Click OK. 
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Figure 53: Cancel Order 
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5.16.1. Cancel/Replace Orders -Hotkeys 

 

Figure 54: Cancel/Replace Orders -Hotkeys 

More information on Cancel/Replace orders hotkeys is provided in 4.6 Canceling an 
Order. 
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6. Market Maker Window Configuration 

This section explains the configuration of Market Maker window of Graybox. 

6.1. Market Maker Window 

Market Maker window displays the quotes of the selected stock. MM window displays the 
pending orders that are awaiting execution. 

To open a Market Maker window  

• Click New > Market Maker in the Active Order window. You can open multiple 
MM windows.  

 

Figure 55: Market Maker Window 

When you type in the symbol of the stock in the top left field, Market Maker displays the 
live quotes of the stock. 

Market Maker window is divided into two parts. While the upper part displays information 
such as last traded price, bid and ask prices, net change from previous day’s close, and 
volume etc about the selected stock, the lower part displays the real time quotes of Bid 
and Ask for different ECNs in a stream. 

Market Maker window has an option to auto locate symbols. When a symbol for hard to 

borrow stock is entered, a “Locate” button is displayed, using which symbols are 
located.Information displayed in the upper part of Market Maker consists of: 

• Lst: Last Traded Price 

• Net: Net change in price from previous day’s close 

• Vol: Total volume of shares traded 

• Imb: Market and Market on Close imbalances 

Level 1 

View 

Show 
Alerts 

Prints 
Level 2 
Display 
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• Bid & Shr: Highest Bid and number of shares bidded for 

• Ask & Shr: Highest Ask and number of shares on offer 

• Cls: Previous day’s closing price  

• % Int: Percentage of Imbalances with respect to volume traded 

• Opn: Day’s opening price for the stock 

• OBI: Open Bid indicator – shows the approximate bid value 

• Low & Hi: Lowest and highest prices the stock is traded for the day 

• Time: Last traded time 

• OAI: Open Ask indicator – shows the approximate Ask value 

• Thermograph: Indicates volume trend. Green indicates higher volume in Ask 

orders, while red indicates higher volume in Bid orders 

You can change the display in Market Maker view for Level1/Level2/Thermograph and 

Prints. 

To change the display, Select/Deselect – Level1/Level2/Thermograph and Prints, 
depending on the view you want to set. 

 

Figure 56: Market Maker View Setting Menu 

 

For the active symbol in Market Maker window, Market data can be 
accessed by clicking on the Open Yahoo! Finance link on the 

settings menu, A keyboard shortcut key can also be defined from 

the Keyboard Configuration settings for quick access.  

This will open the Yahoo Finance page with the active symbol. 

 

6.1.1. Level 1 Display 

This section explains Level 1 display of Market Maker. 

 

6.1.1.1. Use Primary Exchange for Last Price 

You can use primary exchange for last price in the Market Maker. To set primary 
exchange: 
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• Right-click in the Market Maker window, select Setup > Level1Quotes 

>Use Primary Exchange for Last Price. 

 

Figure 57: Market Maker Window for Level 1 Display 

 

6.1.2. Level 2 Display 

This section explains Level 2 display of Market Maker. 

6.1.2.1. Changing Display of ECN Books 

ECN books shown in the Market Maker window can be either Inside Market or full 
market. You can change the display of ECN books.  

To change the display of ECN books: 

• From the Market Maker menu, Select ECN Books, then select the market 
you want to view for the ECN Book. See Figure 58.  
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Figure 58: ECN Books Configuration Window 

 

6.1.2.2. Highlighting a Particular Market Maker  

You can highlight a particular Market Maker. This draws attention to the spurt in 
the movement of the stocks. To highlight a particular Market Maker: 

1. Select Hi-Lite MarketMaker in the Market Maker menu. Hi-Lite 
MarketMakers window appears. 

 

Figure 59: Hi-Lite Market Makers Window 

2. Select the Market Maker, and then Click >> to move the selected Market 
Maker to Hi-Lite.  

 

You can select and highlight multiple Market Makers. Repeat step 2 
for each Market Maker you want to highlight. 

3. From the dropdown menu of Style field, select either black or red as the 

highlighted color. 

4. Click OK to save.  
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6.1.2.3. Ignore Market Maker Quotes 

You can clear the Market Makers and ECNs from Graybox display. This does not 
remove them permanently.  When you reload the box, they re-appear. 

If you select Ignore All Crossed Quotes, then all quotes that do not match with 
the level 1 data are automatically ignored.  

      

     Figure 60: Ignore Market Maker Quotes Window 

You can also save the list of Ignored Market Maker in the Graybox layout. 

To get back the Ignored Market Makers:  

• Open Ignore MarketMaker Quotes window and remove the required Ignore 
Market Makers from the Ignores list. 

To move the MarketMakers from Ignores to Visible box individually,  

• Select the required MarketMaker and click <.  

To empty the Ignores list,  

• Click <<. 

 

6.1.2.4. Sorting and Rounding quotes in the Market Maker Window   

You can customize the order of the MarketMakers and ECNs by sorting. SeeFigure 
61. If you select Volume, the MarketMakers and ECNs are shown in the order of 
highest volume.  

Similarly the quotes can be rounded off to the nearest selected value.  

      

Figure 61: Market Maker Window for Sort & Round Quotes 
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6.1.2.5. Order Buttons in the Order Entry Window 

You can customize column headers in the order entry window of the Market 
Maker. This enables you to view the orders of selected ECNs as you prioritize 

them. 

To customize: 

1. Right-click the market maker window, select Setup > OrderEntry 

Window > Order Buttons.  The Order Buttons window is displayed. 

See Figure 62. 

 

     Figure 62: Order Buttons Window 

2. Select the required headers and move to Column Headers. 

6.1.3. Prints 

You can set the Prints area of Market Maker window. To set the Prints area: 

Select Setup > Prints in the Market Maker menu. See Figure 63.  

 

Figure 63: Market Maker Menu Window 

You can enable/disable “Show Time, Show Exchange Id, and Change Order”. This 
shows the time and exchange Id in the Prints area. The Change Order option is used 
to change the display area in the Prints Area. See Figure 64. 
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Figure 64: Prints Area of Market Maker Window 

 

6.1.3.1. Filtering the Prints Display 

You can filter the Prints of the Market Maker window. To filter:  

• Select Setup > Prints > Filter. The Prints Filter window appears. See 
Figure 65. 

 

  Figure 65: Prints - Filter Window 

6.1.3.2. Showing/Hiding the Time 

You can set the Showing/Hiding the Time option as per the requirements  

To show and remove the time in the Prints column: 

• Right click on the Market Maker window, select SetUp > Prints > Show 
Time. 

Exchange ID 
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6.1.3.3. Always On Top 

You can set Market Maker window Always On Top of other windows or screens of 
the Graybox application.  

To set Market Maker window Always On Top: 

• Select Always On Top in the Market Maker menu. See Figure 63.  

 

Minimizing Graybox minimizes all Graybox quote display windows. 

 

6.1.3.4. Changing the Font 

You can set different fonts for different stocks and price levels in the Market 
Maker window. To change Fonts:  

1. Select Setup > Font > Custom.  

2. Select the required Font and Click OK or click Auto Size to return to 
original. 

6.1.3.5. Changing the Colors for Price Levels 

You can change colors for different stocks and price levels in the Market Maker 

Window. To change the colors: 

1. Select Colors, Setup > Color > Custom.  

 

Figure 66: Custom Color Window 

2. Click the color for the price level you want to change. The window Color 

menu appears. 

3. Select the color you want to use, and then click OK. 

 

Alternatively,  

Click Define Custom Colors, select the color on the window, and 

then click OK. 

4. Click OK to save changes or click Default to return to original. 
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6.2. Time & Sales 

Time & Sales provides with real time data of securities with volume, time of 
execution, price and exchange.  

You can open Time and Sales by clicking the   icon from “Order Entry” or 

“Market Maker” window. See Figure 67. 

Menu in time and sales has options to change colors, display the data with gridline 
and show quantity in multiple of 100s for easy visibility.  

    

Figure 67: Time & Sales window.  

Search options available are  

• Get Last – available in conditions of a minute to hours and Full day. See 
Figure 68  

• Custom – Available for a selected date, between a time intervals. See 
Figure 69 
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Figure 68: Time & Sales Get Last Search 

 

Figure 69: Time & Sales Custom Search 

 

• Data in Time and Sales can be customized and filtered according to 
Exchange, Trade Condition (Trades, Bids and Asks) and Minimum Size. 
See Figure 70 
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Figure 70: Time & Sales Filter 

 

6.3. ECN Book Window 

You can set the ECN books in the Market Maker window to Inside Market, full market, or 
none. In the Inside Market setting, you can see the best Bid and Ask on that ECN.  In 

the full market setting, you can see the list of all the Bids and Asks at different levels for 
all the available ECNs.  

ECN Books can be opened from the “New” menu from Graybox active order window, or 
through the  icon in active order window, or from market maker window. 

To change the display: 

1. Select ECN Books in the Market Maker menu, and then select the ECN Book view. 

2. Repeat step 1 for each ECN book, as required.  

To open a window for ECN Book quotes:  

Click  in the shortcut bar or in the MM box Click .  

 

ECN books brought up in this fashion are automatically linked to the 
MM box. 
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Figure 71: ECN Book - Power Shares Exchange 

6.3.1. Changing the Colors 

You can change the colors for different stocks and price levels. To change the colors, 
Refer 5.11 Graybox Main Window – Setting Colors. To change back to the Default 

Colors, Select Setup Colors in the ECN Book menu, then Select Default. 

 

Figure 72: Default Color Setting 

6.3.2. Changing the Font 

You can set different fonts for different stocks and price levels in the ECN Book. To 
change the Font, see 5.12 Graybox Main Window – Setting Font. 

6.3.3. Showing/Hiding Executions and Cancels 

You can set the Showing/Hiding Executions and Cancels in the ECN Book. 
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To show or hide the Executions column: 

1. Select Show Executions in the ECN Book menu. 

2. Select Show Cancels in the ECN Book menu. 

 

6.3.4. Filtering ECNs in the ECN Book  

You can filter ECNs in the ECN Book. 

To filter ECNs in the ECN Book: 

1. Select Filter in the ECN Book menu. The ECN Book Filter window appears. 
See Figure 73. 

        

       Figure 73: ECN Book Filter Window 

2. Type the name of the ECN in the ECN field, then Click Add. The added ECN 

appears in the Filtered List field.  

3. Click OK. 

To remove any ECN from the Filtered List,  

• Select the ECN, Click Remove, and Click OK.  

6.3.5. ECN Book Window – Always On Top 

You can place the ECN Book window Always On Top of any other windows or 

screens. To set the ECN Book window appear Always On Top: 

Select Always On Top in the ECN Book menu.  

6.3.6. ECN Book Window – Aggregate by Price 

You can set the ECNs on price aggregate. For example, instead of viewing all the 
INET bids at a particular price, you can view one bid with the volume aggregated for 
ECNs. 

6.4. Charts 

You can view the movement of the stock through different charts such as tick, bar, 
candle, line, and day charts.  For example, Tick chart view of IBM stock is as displayed in 
Figure 74.  

To open charts:  

Click the   icon in the Market Maker window and select the appropriate chart view 

from the dropdown menu for your chosen stock.  
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Figure 74: Chart View of a Stock 

6.4.1. Interval 

An interval is a gap between prints to be plotted. You can set an interval to Bar and 
Day charts. An Interval can vary from 1 minute to one day based on the type of 
Chart.  

 

An Interval cannot be set for Tick Chart. 

To set the interval, Right Click on chart and Select Interval or use the drop down 
box option to set interval as shown below in Figure 75.  

 

Figure 75: Interval Setting Window 
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6.4.2. Show Last 

Along with the interval, you can also set the Show Last duration for the chart 

display. 

To set Show Last Right Click on chart and Select Show Last or use the drop down 

box option to set Show last option as shown below in Figure 76: 

 

Figure 76: Show Last Setting Window 

 

6.4.3. Edit Chart Dialog 

You can also set Interval, Show Last, and Chart Type through Edit Chart Setup. To 
set through Edit Chart Setup, Click on the Edit Chart setup Icon in the chart, or 
Right click and select Edit Chart option. The Chart Setting Dialog window appears. 
See Figure 77. Chart Setting Dialog window enables you to make settings in Tick 

Chart, Bar Chart, and Day Chart tabs.  

 

Figure 77: Chart Settings Dialog Window 
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6.4.4. Show Volume 

Along with the interval, you can also set the “Show Volume” duration for the chart 
display. To set the “Show Volume”:  

Right-click chart window, and select Show Volume. 

 

Figure 78: Show Volume 

6.4.5. Information Panel 

You can view the details like date, time, Current value, and volume along with the 
chart display. To set the “Information panel”:  

Click on the Info Panel Icon in the chart or Right click on the chart window, and 

select Information Panel from the menu. See Figure 79 

This dropdown menu consists of the following options: 

o Always On 

o On Mouse Click 

o Never 
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Figure 79: Information Panel 

 

6.4.6. Series Style 

To set the Series Style, Right click on chart window, and select Series Style and 
then select the required option. See Figure 80 

This Dropdown menu consists of the following options: 

o Solid 

o Dot 

o Dash Dot 

 

Figure 80: Series Style 
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6.4.7. Color Settings 

You can set the thickness of the chart line, background, and foreground color of the 

chart area. To set the ”Color Settings”, Right click on chart window, and select Color 

Settings from the Market Maker menu. See Figure 81 

 

Figure 81: Color Settings 

Apart from Series and Color, the Weight Dropdown menu consists of the following 
options: 

o Thin 

o Med 

o Thick 

o Very Thick 

Other options such as the background, foreground and trend line colors can be chosen, 
along with the colors specific to the chart.  

6.4.8. View Chart Data 

You can view the chart data in the case of Bar Chart. To view the chart data, Right 
click on chart window, and select the view chart data. See Figure 82 

 

Figure 82: Chart Data Point 
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6.4.9. Draw Trend Lines 

You can draw trend lines over the chart to indicate a trend. To draw a trend line, 

Right click on chart window and select “Draw Trend Line” or click on the “Trend Line” 
Icon. See Figure 83.    

 

Figure 83: Draw Trend Line 

6.4.10. Draw Horizontal Lines 

You can draw Horizontal lines over the chart to indicate highs and lows. To draw a 
Horizontal line, Right click on chart window and select “Horizontal Line”. See Figure 
84.    

 

 

Figure 84: Draw Horizontal Line 
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6.4.11. Studies 

You can do technical analysis of charts by using the studies option. To select 

“Studies”  Right click on chart window and select “Studies”, or click on “Studies” 
Icon. See Figure 85.    

 

 

Figure 85: Chart Studies Selection 

The “Studies” options available are 

• Simple Moving Average 

• Exponential Moving Average 

• Weighted Moving Average 

• Momentum Oscillator 

• MACD 

• Bollinger Bands 

• Relative Strength Index 

• Stochastic Oscillator 

• Stochastic Momentum Index 

• MACD Histogram  

 

6.4.11.1. Selecting a Study – SMA 

After selecting “Studies” you can choose “Simple Moving Average” and click “Add 
Indicator”. The “Simple Moving Average” will be added to the list and a settings 

dialog for the study “Simple Moving Average” will be displayed. See Figure 86.  

 

Figure 86: Chart Studies - SMA Settings 
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Once the Settings are chosen, click “Apply”. A chart with “Simple Moving 

Average” value and pattern will be displayed. See Figure 87 

 

 

Figure 87: Chart Studies SMA 

 

6.4.11.2. Multiple Studies 

Similarly you can choose multiple studies for Technical analysis. Simply choose 

the required study from the “Studies” dialog box and click on “Add Indicator. See 
Figure 88 

You can also choose multiple settings of the same study for technical analysis.  

 

Figure 88: Chart Studies – Multiple Studies 
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6.4.11.3. Merge Charts 

Merge Charts provides comparison of price movements between two symbols. 
You can merge price movements of two symbols by choosing the “Merged” option 

from the “Edit Chart” Dialog box.  

From the “Edit Chart” dialog box enter the “Linked Sym” and “Overlay Sym”. 
Choose the type of graph to display, put a check mark on the “Merged” box and 
click “OK”.  See Figure 89 

 

Figure 89: Merge Chart Settings 

The Merged charts is displayed as shown in Figure 90 

 

Figure 90: Merged Charts 

 

 

Options in Sections 6.4.11 are not available with chart type Tick Chart. 
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6.5. BoardView  

Graybox BoardView provides trading information such as Last Traded Price, Net Change, 
Best Bid, Best Size, Best Ask, and Best Size etc for selected stocks. 

BoardView can also be used to send Basket orders. Basket order option is available from 
the sub menu as shown below.  

1. Click the  icon in Graybox main window. The Graybox Broadview window 

appears.  

2. Right-Click the BoardView window. The Broadview window sub menu appears. 

See Figure 91. 

 

Figure 91: GrayBox BoardView Window 

6.5.1. Adding Symbols 

You can add stock symbols from the BoardView. You can add as many symbols as 
required.  

Type in the symbol number,  

• Press ENTER, and then type in another symbol. The typed symbols are 

added to the BoardView. 

To add symbols,  

• Right-Click the BoardView window, Click on Symbols. See Figure 92. Add 
required Symbols. Click OK. 

Board View after adding the symbols appears as shown in Figure 92. 

 

Figure 92: Graybox BoardView with Symbols Added 

 

Symbols in BoardView can be dragged and dropped to Market Maker 
window. Market Maker window will show the dropped symbol 
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6.5.2. Imbalances 

Imbalances of the symbol can be displayed in board view by selected the Imbalance 
columns from Column setup. Imabalnces of both NASDAQ and NYSE stocks are 

available. When “Imb” and “Imb%” columns are selected, the imbalances will be 
displayed when the Imbalance data is available.  

6.5.3. Load from Analytics  

You can load stocks from Analytics. Analytics option provides All and Top 10 to 30 
Imbalances for Buy, Sells, and Both for the day. Top 10 to 30 imbalances can be 
loaded by percentage also. See Figure 93. This allows you to make instant trading 

decisions and take or switch between positions based on Analytics. 

To Load from Analytics, right-click the BoardView window. The sub menu appears. 
See Figure 93. 

 

Figure 93: Load from Analytics Window 

6.5.4. Customizing  Headers 

You can customize the Column Headers in the BoardView default screen.  

To customize Column Headers,  

1. Click on the  icon in Graybox main window. Graybox Broadview 

window appears. 

2. Right-Click the BoardView window. The sub menu appears. Figure 94. 

3. Right-click > Setup > Columns Select/Deselect the Column Headers 

using the > and < arrows. 

You can also rearrange the Column Headers by selecting and moving them Up and 
Down to see the BoardView in required order. See Figure 94. 
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Figure 94: Column Headers for BoardView 

6.5.5. General Option  

You can make General Setup of BoardView. Select the General Option in the 
submenu. The BoardView Setup General window appears. See Figure 95. 

 

Figure 95: BoardView Setup General Window 

The window is self-explanatory and you can select the required options.  

6.5.6. Refresh Interval 

You can set a refresh interval option to refresh the BoardView. Setting this option 

refreshes trading data information of a specific stock at specified intervals and 
enables you to make or change trading decisions. 

This setting is generally for the BoardView to sync up with the MM window’s Level 1 
data and is particularly useful for stocks traded with very low volumes or not traded.   

 

Figure 96: BoardView Refresh Interval Window 
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6.6. Ticker 

To open a separate Ticker,  

• Click the  in the Graybox main menu. 

The right-click option consists of the following options: 

o Setup 

o Show Time 

o Caption 

o Always on Top 

o Jet 

o Cascade 

o Format – shows the option of Colors and Fonts 

o Clear 

6.6.1. Setting Up the Ticker 

To set up the ticker, 

• Right-click ticker panel, and Select Setup. Ticker Setup window appears. You can 

add symbols as shown in Figure 97. 

 

Figure 97: Ticker Setup Window 

You can Select either Jet or Cascade Format and insert them at Top or Bottom of the 
window. See Figure 97: Ticker Setup Window. Here, Cascade mode and Bottom 

options are selected.  

Show Time Ticker in Cascade and Jet Modes are shown in Figure 98 and Figure 99 
respectively. 
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Figure 98: Cascade Ticker  

 

Figure 99: Jet Ticker 

6.7. NYSE Open Book 

NYSE Open Book provides a real-time view of the Exchange's limit-order book for all 
NYSE-traded securities. Through the NYSE Open Book, you can see aggregate limit-order 

volume at every bid and offer price and the depth-of-market data.  

To open the NYSE Open Book,  

• Click on the  icon in Market Maker window or click the  icon in Main 

Menu. 

 

Figure 100: NYSE Open Book Window 
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6.7.1. Set Up Colors/Font  

You can set up Color/Font as shown in Figure 100.  

6.7.2. Show Size in 100s  

You can set the Qty display size in 100s as shown in Figure 100.  

6.7.3. Show Time  

You can set the Show Time option. See Figure 100. Enabling this option displays 
time.  You can disable this option by clearing it. 

6.8. Hedges and Locates 

Hedges and Locates window shows the hedges taken by the trader.  

 

 

Figure 101: Hedges and Locates Window 
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6.9. Market Clock 

Market Clock shows the current market time with date and market open close 
status.  

Market clock is opened from the Order entry Window, View, Market Clock.  

See Figure 102  

                 

Figure 102: Market Clock 
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7. Back Office Functions 

This section explains the back office functions of Graybox. 

7.1. Viewing Statistics 

The Statistics screen shows all your trades for the day with the number of trades, the 
volume on ECNs, SelectNet, and Profit and Loss. 

7.2. Graybox API 

Details of Graybox API is available in http://support.hold.com/api 

7.3. Web Blotter 

Web Blotter with details of trading can be accessed from Graybox main window, Tools 

menu�, Web Blotter.  
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8. Appendix 

8.1. Frequently Asked Questions (FAQ’s) 

1) How to load or save the layout? 

To Load a Layout go to File Menu � Layout � Load - Choose a layout from the pre saved 
xml layouts. 

To save a Layout Go to File Menu �Layout � Save - After making changes to existing 

Layout save layout. 

To save to a different name  go to File Menu � Layout � Save as, give a name and 
save.  

Alternatively layouts can be loaded, and saved using the options available from the right 
click menu of the Graybox main window. 

 

2) Moving  the main window, the position window also moves along, How to 

avoid this? 

To avoid this, change settings on the Trading options. To change - Right click on the 
main window � Trading Options � Positions Dialog Mode (at bottom left side) Change it 

from Docked to Floating. 

 

3) How to enable or disable the Mini- order entry part on the MM window? 

In the Marketmaker window right click � View �  Mini Order Entry. If there is a check 
mark then Mini - order window is enabled. Uncheck to disable mini order entry 

 

4) How to enable or disable the Order- entry part of the MM window ? 

In the MM window right click �View � Order entry. If there is a check mark then Order 
entry window is enabled. Uncheck to disable order entry window.  

 

5) How to limit number of ECN order buttons displayed in the Order Entry 

Window? 

To view only certain ECN order entry buttons in Order entry window, In the MM window 

right Click �Setup � Order Entry Window � Configure order entry button.  A new 
window Opens. Two panes display the ECN button options, right  side pane displays ECN 
buttons that are available in order entry window, left side pane shows buttons that are 
not available. Selecting the ECN and moving them between the two panes will change 

the order entry buttons accordingly. 

 

6) How to highlight ECNs in the Level 2 area of MM Window? 

To Hi-Light certain ECN's, In the MM window right Click � Hi-Light Market Makers � A 

new window will open, Select the ECN's that needs to be hi-lighted and click the button " 
> " to move the selected ECN's to Hi-Lite (from left pane to right pane) then click OK. 

 

7) How to remove crossed quotes? 
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To remove crossed quotes, In the MM window right Click � Ignore Market Makers � A 

new window will open. In that window put a check mark net to “Ignore All Crossed 

Quotes”. 

 

8) How to ignore unwanted ECNs in level 2 montage of Marketmaker window? 

 To view only certain ECN's, In the Marketmaker window right Click � Ignore Market 

Makers � A new window will open 

By default all ECN's will be Visible - to remove unwanted ECN's from MM window Select 

the ECN's and click the button " > " to move the selected ECN's from Visibles to  Ignores 
then click OK. 

 

9) How to open Boardview and include stocks on it? 

To open a Boardview from the main window select the New menu � Boardview � A new 
Boardview window will open. Enter the stock and hit enter. Do the same to add more 
stocks in that Boardview. 

Alternatively Boardview can be opened from Graybox main window and Marketmaker 
window by clicking on the Boardview Icon.  

 

10) How to open Charts on Graybox? 

In the MM window or in the main window click on the charts icon to launch charts.  

Charts can be opened from the New menu� Chart�, this will also open a chart. 

Historical data has to be enabled for seeing old data in charts, contact us for details.  

Otherwise only current data is updated.  

 

11) How long does it take to master the software? 

Depends on person to person and how often how often you use it. Based on the existing 

customer experience it takes 2-3 weeks. 

 

12) How often is Graybox™ software updated? 

Since our Graybox software is developed by traders for traders and we utilize in house 
programmers, it's updated whenever our programmers determine there's a better way to 
enable your trades. Instead of waiting for quarterly major updates, fine-tuning updates 

are generally released every few weeks. Hold Brothers has placed over 70 man years of 
programming into Graybox™. 

 

13) Do you offer tech support for Graybox™ software? 

Yes. Contact support@hold.com; helpdesk@hold.com; or call 646-745-2222. 

 

14) What kinds of securities can Graybox™ software handle? 

Our Graybox software enables you to trade NASDAQ and NYSE and AMEX listed stocks.  

 

15) What trading styles can Graybox™ software handle? 

Scalper, momentum, position, rebate and swing. We haven't met a style we couldn't 

handle.  
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16) Can I use third-party quotes with Graybox™ software? 

Yes. Graybox software currently links to eSignal. Contact us (support@hold.com) for 
details. 

 

17) What if my quotes in market maker window are stuck? 

Use the option to reconnect to servers when your quotes are stuck. This is available from 
the menu “Configuration�Reconnect All –Use Primary Settings” or  
“Configuration�Reconnect All –Use Secondary Settings” from the Graybox active order 

window.  
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8.2. Graybox Installation 

8.2.1. Computer requirements 

Big is good. Faster's even better. Graybox is available in 64 bit and 32 bit versions and is 
compatible with Windows 7, Vista, Windows XP and Window 2000, Intel Core 2 Duo 2.4 

GHz or higher, 4 GB RAM, VGA adapter with a minimum of 128MB on-board video 
memory. 
 

8.2.2. Supported Internet Connections 

Cable modem, DSL, ISDN, T1, and T3.  Dial-up connections are just not fast enough to 

support Graybox™ software. 
Using a Wireless connection is not advised because there might be a latency/delay 
between the wireless router and your PC which will slow the data flow.  

 

8.2.3. Graybox Installation & Configuration 

Graybox Installer software is available at http://support.hold.com/  
Download the file and double click to install.  

Follow on screen instructions to complete installation.  
Installer will configure the software automatically. If you need information on 
configuration, please check “Server Configuration” link in http://support.hold.com/. 
 

 

8.3. Graybox Exchange codes displayed in Prints 

Destination ID Exchange Name/ Description 

A NYSE AMEX 

B NASDAQ OMX BX 

C National Stock Exchange 

D FINRA 

E Consolidated Quotation System 

I International Securities Exchange 

J Direct Edge A 

K Direct Edge X 

M Chicago Stock Exchange 

N New York Stock Exchange 

P NYSE Arca SM 

T NASDAQ OMX 

W CBOE Stock Exchange 

X NASDAQ OMX PSX 

Y BATS Y-Exchange, Inc. 

Z BATS Exchange, Inc. 

 

 
 



Graybox – User Manual_v3.63  

 

 

93 

8.4. Graybox Symbology 

Type Of Symbol 

 

 

 

Graybox Standard  

(max 8 chars) 

Preferred XXX$ 

Preferred Class A (also B-T and V-Z) XXX$A 

Class A (also B-T and V-Z) XXX.A 

Preferred When Distributed XXX$.D 

When Distributed XXX.D 

Warrants XXX.W 

Warrants Class A (also B-T and V-Z) XXX.W.A 

Called XXX* 

Class A Called(also B-T and V-Z) XXX.A* 

Preferred Called XXX$* 

Preferred "A" Called (also B-T and V-Z) XXX$.A* 

Preferred “A” When Issues (also B-T and V-Z) XXX$.A.V 

Emerging Company MarketPlace XXX.E 

Partial Paid XXX@  

Convertible XXX% 

Class Convertible XXX.A% 

Covertible Called XXX%* 

Rights XXX.R 

Units XXX.U 

When Issued XXX.V 

Rights When Issued XXX.R.V 

Preferred When Issued XXX$.V 

Class "A" When Issued  (also B-T and V-Z) XXX.A.V 

Warrant When Issued XXX.W.V 
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Glossary 

 

Term  Description 

AMEX 

 

American Stock Exchange (AMEX) is a stock exchange situated in 
New York and was a mutual organization, owned by its members. 

BATS BATS is a stock exchange based in Lenexa, Kansas, Missouri and 
was founded in June 2005 as an ECN and its name stands for Better 
Alternative Trading System. In early 2009 it became the third 

largest exchange in the world by volume behind the New York Stock 
Exchange and NASDAQ. 

BoardView BoardView is the feature available in the Graybox which provides 

trading information such as Last Traded Price, Net Change, Best Bid, 

Best Size, Best Ask, and Best Size etc for selected stocks. 

ECN Electronic Communications Network (ECN) is a completely 

automated network, anonymously matching buy and sell orders and 
has been described as the “black box” of securities trading. 

ESignal ESignal is charting software which can be linked with the application 

Graybox. 

Graybox Graybox™ trading software application from Hold Software.com Inc 
is a state-of-the art, easily configurable trading software to date. 

Locates 
monitor 
Window 

This window shows the stocks available for the trader which can be 
the deciding factor for the short sell of those stocks. 

 

Market 
Maker 

Window 

Market Maker window displays the quotes of the selected stock and 
pending orders awaiting execution. 

NASDAQ National Association of Securities Dealers Automated Quotations 

(NASDAQ) is an American stock exchange which is the largest 
electronic screen-based equity securities trading market in the 

United States. 

Notifier 
Window 

The Notifier window displays all system messages related to Graybox 
which include periodic system announcements that are made by the 

Graybox system administrators. 

NYSE The New York Stock Exchange (NYSE) is a stock exchange located 
at New York City, USA and is the world's largest stock exchange by 

market capitalization of its listed companies.  

Position 
Window 

The Position window displays stock position details. This window is 
divided into two parts. The upper part of the window displays a 

detailed stock position and the lower part displays the summary.  
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INDEX 

B 

basics, 9 

BoardView, 81, 82, 83, 94 

C 

Cancel Order, 37, 56, 57 

Canceling an order, 37 

Changing a particular order, 26 

Charts, 8, 71 

Configuration, 11, 49, 50, 55, 59, 62 

D 

DAY orders, 42 

Default Quantity, 40, 44 

Display Size Defaults/ECN, 43 

Dynamic smart orders, 47 

E 

Edit Chart Dialog, 73 

ESignal, 45, 56, 94 

G 

Graybox Main Window, 10, 13, 52, 53, 54, 

70 

Graybox trading, 8 

H 

Hidden, 40 

L 

Links, 55 

M 

main window, 9, 10, 21, 37, 38, 42, 45, 50, 

52, 53, 56 

Manual Order Entry, 11, 38, 41 

Market Maker, 25, 29, 40, 41, 47, 50, 59, 

60, 61, 62, 63, 64, 65, 66, 69, 71, 72, 73, 

74, 76, 85, 94 

Messages window, 16, 17, 37 

Multiple Swipe Keys, 48 

N 

Normal, 40, 42 

O 

Order Display Mode, 39, 40 

Order Entry, 25, 26, 28, 29, 38, 41, 45, 64 

P 

Password, 9, 10, 13, 56 

Preference window, 33, 34 

Prints, 60, 64, 65 

R 

Router Settings, 55 

S 

Setting the Colors, 53 

Setting the Font, 53 

Setting the Sounds, 54 

Setting Up Keyboard Shortcuts, 50 

Setting Up Smart Order Routing, 45 

Showing/Hiding the Time, 65 

T 

The Super ECN Key, 47, 48 

Ticker, 11, 23, 84, 85 

Trading, 11, 25, 28, 30, 33, 37, 38, 39, 41, 

48, 50, 56, 94 

Trailing Stop Order, 51 
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user entitlements, 14 

 


